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Chapter 1 — Introduction

The Nevada Commission on Peace Officers’ Standards and Training (POST) is charged with keeping
information on law enforcement agencies, courses, and officers throughout the state of Nevada. In
order for officer's to be awarded professional certificates of all levels, agencies must apply for each
certification for each officer that qualifies.

To make this process easy and efficient, POST has implemented an online software solution that
allows entering applications for all the various levels of POST professional certifications to be
approved and processed by POST.

What is Formatta?

It is user-friendly, electronic form filling software that will allow agencies to enter, save, and submit
applications for professional certificates; which will be approved and processed by POST. Agencies
will access the POST Formatta form via the Internet and download the Formatta Filler software,
which enables them to fill out, save and submit forms for their officer's professional certificates.
There are four steps to accomplish this; which are discussed in this document:

1 Download and install the Formatta Filler client software on the agency computer.

NOTE Step 1 is completed only one time per computer that will be used to submit Formatta forms.

2 Using your Internet browser, access the POST Formatta Available Forms web page.
3 Open the Professional Certificate Application form and log in.

4  Enter the officer’s qualifications, attach required documents, and submit.
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Using the Formatta Filler Software

As you work with the form, you can save work-in-progress and come back to it later for completion,
or save a completed form for your records. From the File menu, select Save As... and give the
form a unique file name so you can find it when you need to. You can also print the form by
selecting Print.... from the File menu and selecting your printer.

% Edit “iew Form Tools Help

apen...
Close

Save As..,

Export
Send...

Print...
Print Preview

Bubble Tips

Bubble Tips are available for every field, checkbox, and button in the form. When you click in a field,
select a checkbox, or click a button, an explanation will pop-up to assist you with the entry.

Enter the POST
identification number f P
assigned to the officer. IS0l

Post ID Number: Iil Loolup

You can turn the Bubble Tips feature off and on by selecting Bubble Tips from the View menu.

Form Tools Help

v Toolbar
v Status Bar

Bubble Tips

Pop-up Date Calendar

When you click into the Effective Date field, a calendar pops up allowing you to select a date. Use
the arrows at the top to scroll through the months and years to select the correct date.

Sun Mon Tue YWed Thu Fri Sat
24 25 26 27 28 29 30
12 3 4 5 B 7

8 9 10 11 12 13 14
15 16 17 18 19 20 21

22 23 24 26 27 28
29 30 3 1 2 3 14
[ |Today: 572542011




Using the Formatta Form.: Professional Certificate Application Chapter 1 — Introduction

You can turn the Calendar feature off and on by selecting Calendar from the View menu.

Form Tools Help

v Toolbar
v Status Bar

v Bubble Tips
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Chapter 2 — Setting Up Your Computer

The first step in using the POST Formatta form, is for the agency to download and install the Formatta Filler
client software on a local computer Downloading and installing the Formatta Filler software is required only

once on any computer that will be used to submit Formatta forms to POST. This client software is for
Windows operating systems.

Download the Formatta Filler Software

1 Open the web browser on your computer.

2 Enter http://eforms.post.state.nv.us/efm/catalog/publishedforms.jsp into the address bar.

You will see the following web page:
@ )= @] hitp://10.128.209.1:8080/efm cataog/publshedforms Jsp

File Edit ‘iew Favorites Tools Help

L[ Favorites | 9 @ |Earthclimate @& | Time Sheet Calculator €2 | Home - EM -". current time - Google Search @ | Forms-driven Business Pr

@ Formatta E-Forms Manager - Form Infor...

.- formatta

Available Forms

By Category m - Search

Form Title 'S B Category Description Download

Update - Personnel Action Report Uncategorized Update - Personnel Action Report (PAR) b

| Formatta

= Filler
FREE DOWMNLOAD

Add a Shortcut to your Desktop

3 Before downloading the software, right-click anywhere on the web page and from the menu, select to

Create Shortcut; which will put a shortcut icon on your desktop so you can easily access this web page
in the future.

1 formatta Back .

- Save Background As...
Available Form Set as Background

By Category . Copy Background

Select Al

»
T Al Accelerators
& 2 Ut

lindate - Berennnel Ertind
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The shortcut on your desktop will look something like:
4 You can change the icon and rename it like any other shortcut on your desktop to make it easy for you to
identify and quickly access the POST Formatta form.

Start the Download
From the Available Forms web page, click on the Formatta Filler Free Download button located in the

1
middle of the page.
Available Forms
By Category m - Search
Description Download
Update - Personnel Action Report (PAR) b

Form Title L Category
Update - Personnel Action Report Uncategorized
Formatta

Filler

(i

FREE DOWNLDOA

The File Download — Security Warning pop-up message appears (The following messages and dialogs are
from installing on XP; which may be different if installing on Vista, Windows 7 or Windows 8).

File Download - Security Warning

Do you want to run or save this file?

MName: FillerSetup.exe

. Tywpe: Application, 1.24MB
Fram: www2. formatta.com
] [ Cancel

|| save

Fun

While files from the Internet can be useful, this file type can potentially
harm wour computer. If you do nottrustthe source, do not run or save this

- software. What's the risk?

2 Click the Save button.
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3 From the Save As dialog, save the FillerSetup.exe to your Desktop folder.

&

Save As
Save in: i@ Deskiop M v | J ¥ [
M
g My Documents [ Microsoft Office Excel 2007
Iéb | My CompLiter _@Microsoft Office FrontPage 2003
by Recent |‘-3My Network Flaces EMicrosoft Office Publisher 2003
Documents |- Adobe Acrobat 7.0 Professional EMicrosoft Office word 2003
? 8 idaobe Reader 9 i Microsoft Office Word 2007
L iﬂBusiness Series Terminals Desktop Assistant v 1.3 Microsoﬂ: PhotoDraw 2
Desktop IEC CURE System & Notepad
| = =
ERDYMO Label BlPowerPaint 2003
= ——— iEﬂIFS Desktop 2.1 &)Production smgr
__j [ Intervideo WinovD iR emote Deskiop Connection
EiMedia Player Classic s ScresnHunter 5.1 Free
My Documents i p it NET BITEST smgr.exe
!ﬁi Roxio Creator Basic w3 G Training Manager Academy
';] B Command Prompt By windows Media Player
;_;-! B Filersetp.exe Bl Windows Movie Maker
My Computer  |igl Formatta Designer B2 Winix Video Corverter
| Microsoft Gffice Excel 2003
9 | >
Ry Metwark, )
Flaces File name: v |
Sawe as type: !Application b |

4 Once the download completes, find the FillerSetup.exe icon on your desktop.

Fllersetip.exe

It should look something like this:

Install the Formatta Filler Software

1 Close all programs that are running on your computer.

2 Double-click on the FillerSetup.exe icon to begin installing Formatta Filler software on your computer.



Using the Formatta Form.: Professional Certificate Application Chapter 2 — Setting Up Your Computer

The Open File — Security Warning pop-up message appears.

Open File - Security Warning

The publisher could not be verified. Are you sure you want to run this
software?

Mame: FillarSetup.exe
Fublisher: Unknown Publisher
Tywpe: application
From: C:\Docurnents and Settingsismicallef. POSTDesktop

| Rwm || cancel

[] Alwarys ask before opening this file

This file does not have avalid digital signature that werifies its publisher.
@ “ou should only run software from publishers you trust. How can |
decide what software to run?

3 Click the Run button
4  Follow the directions for installing the software on your computer.

5 Once the Formatta Filler software is successfully installed on your computer, you can delete the
FillerSetup.exe from your Desktop folder.



Using the Formatta Form: Professional Certificate Application Chapter 3 - Using the Professional Certificate

Chapter 3 - Using the Professional
Certificate Application Form

After the Formatta Filler Software is successfully installed on your computer, you can open the Formatta form,
Login, enter an officer’s information, and submit the form to POST.

1 Double-click the shortcut you created on your desktop to access the POST Formatta Forms &

Or, open a web browser and enter http://eforms.post.state.nv.us/efm/catalog/publishedforms.jsp into the
address bar.

2  Click the form icon under the Download heading to open the form.

Professional Certificate Application -E

The request for you to Log in will appear.

This farm requires that you provide a valid username
and password before you can view it. Please enter
yaur username and password below.

sername: |

FPassward:

Submit | Cancel |

3 In the Username field, enter your agency’s POST assigned identification number. (This is a 4 digit
number. It may be preceded by zero(s) to make the 4 digits required for the Username)

4 In the Password field, enter your agency’s POST assigned password.

5 Click the Submit button.



Using the Formatta Form. Professional Certificate Application Chapter 3 - Using the Professional Certificate

The Professional Certificate Application form appears.

Professional Certificate Application
Officer's Mame

POSTIDY | | Loakup || |

Select the Professional Certific ate and choose the applicant's qualifications for the certificate.
Al effiee's hovrs of PO ST tramnd g wesd b mest the ragquinesm smale moss be enbered mto the POST dalabass
fwpe the FOST Training & Complisnce Repori)
Exemptinne e the peood of 300 hoors feaining raqirsd when Spphing or the Monsoame Carsieate par Dae 4 of ROGE1Z
s oplion epires M1 and e 200 howrs Athencad Minegarad Trasong el ks reguired for Dozt Corffliceies

[ State of Nevada - POST j

Meets the follow ing pedq uirerments:

O Interruediate (NAC 280,240) [+]
Heas an Intermediate Certificate and m!l.slh!ﬁi.l:mug Ty uirermneTits:

O Advanced (MAC 280.250) | [~]
Meets the follms ing req uiremenis:

© Supervisor (NAC 289.255) | I~

Has Advanced and Supervisor Certificates and meeds the fiollovring:
© Management (MAC 239,260 [=]

Has a Mamagenent Certificate and meets the following:
O Executive (MAC 280 270) | |:|

Click the Attachments button te submitthe documents that are REQUIRED: Altachments

> Intermediate & Advanced - copy of degree or proof of required credits (if no degree)

> Managament - a kiter cunﬁlmn%juh kel org, chart, proof of B credis (i none previous), 200 hrs. traning®
*> Evecul - @ lefter confirming job kv el, ong. chart, ard proof of 200 hes. Adv Mgmi traning

Additonal Information or comments: | |

By dectrorucally agnng and aibruthng thes form, you attest that the applicant meets the requarements for the
certificate apphed for as sel ot in Gie M evada A derorastrat v Code that s referenced et to the cerificale selscted,

Subrnitters N ame; Subrodtters Phone: Subrnitters E-Mail:
| O - |
Reset Form Subirrat |
b £ 5ion number
== This Section is for POST Approval ONLY **= Do NOT Enterin this Section ==
Education Credit Hours D?I!- Arhieved | App | By: |—| n o

I [¥]1 |
Comene: | T c—

POST Profes el Cartfionts Spp Boakion,
Roiead OPOLNLE

NOTE Ensure all the information you enter is in correct sentence case. Use capital letters and lower case
letters correctly. This will ensure the accuracy and integrity of the information in the POST database.

1 Inthe POST ID Number field, enter the PIN number of the officer for which the application is for and
click the Lookup button. (The form cannot be submitted without clicking the Lookup button.)
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Enter the FOST identification number da - POST

assigned to the officer, then click the . ua
Lookup button. icate Application

-

Officer's Name

POST ID#

Lookup | |

Select the Professional Certificate and choose the applicant's qualifications for the certificate,
All officet's hours of POET traiming used to m eet the requitem ents must be entered into the POST database

e e TR T Ll P L T oA

The current name of the officer in the POST database displays.

State of Nevada - POST
Professional Certificate Application

Officer's Name

POST ID# |29?26 | Tookup |

Select the Professional Certificate

2 Click the radio button of the Professional Certificate for which the application is for: Intermediate,
Advanced, Supervisor, Management or Executive.

3 Then, from the adjacent pull-down, select the qualifications that the officer has met that satisfy the
requirements for awarding the certificate.

Meets the following requirements:

O Intermediate (AT 289 240) ‘

O Advanced (ITAC 2839 2507 ‘

O Supervisor (TTAC 289.255) ‘

O Management (MAC 289.260) |

Has an Intermediate C ertificate and meets the following requirements:

[v]
Meets the following requirements:

[v]
Has Advanced and Supervisor Certificates and meets the following:

[v]
Has a Management Certificate and meets the following:

[+]

O Executive (AC 289.270) |

Note Read the appropriate NAC section for the exact requirements for each certificate.

10
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Attach the REQUIRED Documents

After selecting the certificate and the officer’s qualifications, click the Attachments button and add the
documents required. Make sure you attach the documents that are listed as required on the form for the
certificate being applied for or the application will be denied and returned to you.

Note DO NOT attach certificates from POST certified courses. The course hours for POST courses are only
those that are already in the POST database. Use the POST Training & Compliance Report to enter these
courses for the officer before applying for the certificate

The documents you attach can be in any file type such as TEXT (.txt), WORD (.doc), Adobe (.pdf), Images
(.tif, jpg, bmp, etc.).

4  Click the Attachments button and the following dialog box appears.

Attachments S|
@ Attachments
| L Add |
bl
l Delete l
l SaveAs l
[ Close l

Click the Add button to browse your computer and select files that you want to send with this submission.
Continue to click the Add button and select all the files to submit until the list is complete.

Note You can select a file and click the Delete button to remove it from the list or you can click the SaveAS
button to save a copy of the file to a different location.

Additional Information or Comments

This field is optional and allows you to enter a short explanation or more information about the officer’s
qualifications or application.

11
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Form Submission

This section of the form facilitates the form submission. Entry into all of the fields is mandatory. The form
cannot be submitted and you will receive an error until the information is entered into these fields.

Ev electronically signing and submathing this form, you attest that the applicant meets the requirements for the
cettificate applied for as set outin the MNevada & dministrative Code that is referenced next to the certificate selected.

Submitters Name: Submitters Phone: Submitters E-Mail:

() -
Eeset Form Subitmit

Submission number:

5 In the Submitter’s Name field, enter your first and last name.

6 In the Submitters Phone field, enter a phone number including area code where you can be contacted.
Enter only the numbers and it will be formatted for you.

7 In the Submitters E-Mail field, enter an email address where you can be contacted and the approval
confirmation sent.

Reset Button: If you made a mistake and need to start over, Click the Reset Form button which will
clear all of the fields. Don't click this button unless you really want to start over filling out the form.

8 After all of the officer’s information is entered correctly, click the Submit button.

When the form is submitted successfully, the following Submission Status message appears displaying
the tracking number assigned to the submission. This is a Formatta internal number generated
automatically and is used for software administration purposes.

Ml Submission Status B‘

Thank you for yvour submission. It
has been successfully processed.

Your tracking number for this
submission is 254

OK

9 Click OK.

The following “Thank You for your submission” confirmation message appears.

1z
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Formatta Filler 7.0 §|

\i;) Thank, youl for your submission,

10 Click OK and you are returned to the completed form with the assigned Submission number displayed.

Attachments ‘ Subtrt

Submission number:

At this point, you can save the current form for your records, enter the PIN number for another officer and
complete another form for submission, or exit from Formatta Filler completely.

13
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